Working with Phoenix Digital Data
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1) Describe the standard IR deliverables
2) Pre-work: Acquiring base data, setting up the digital work area, and downloading Phoenix data
3) View Phoenix imagery and shapefiles over base map
4) Create and edit shapefiles, tips and tricks, and making maps
5) Delivering the products 
6) Other information

1) Standard Deliverables
1. Shapefiles, in order of priority:
Heat perimeter (polygon)
Isolated heat sources outside the known perimeter (point)* 
Areas of intense heat (polygon)
Isolated heat sources inside the known perimeter (point)*
Areas of scattered heat (polygon)
* Can be the same shapefile
2. Infrared Map(s) Whether printed out or exported to a PDF, the size and scale of the map should be discussed with the SITL.  If delivering the PDF via ftp, 11” X 17” is not too large to transfer and can be printed out on most desktop printers.  Map must include:
Incident name 
Date and time of IR flight
IRIN name
Legend
Scale
		   North arrow
		   Grid or graticule
Calculated fire perimeter acreage
NIROPS logo
3. Log
Incident name and number
Date and time of IR flight, delivery to IRIN, and product delivery to the incident
Aircraft (144Z or 149Z), scanner (Phoenix), names of pilots and technician (http://fsweb.r4.fs.fed.us/unit/faa/aviation/IRCALENDAR.xls)
IRIN name and contact information
Interpreted (calculated) size of the fire and growth since last report
Observations from the imagery, weather, interpretation notes
[image: ir_log]


2-A) Pre-work: Acquire Base Data
Next, collect the background data for the incident at a large enough extent to allow for spread of the fire.  Gather as many data sets as are available including NAIP quads; dems; topo maps; road, stream, lakes, quad names, etc vector layers; any information that will assist in locating and documenting the map: (Note: if your fire is located in a remote location with little or no Internet capability, you may need to download these data sets before arriving to the incident.
1. Digital orthophoto (NAIP) quads, dems, shaded relief, and DRGs can be downloaded from http://firedata.cr.usgs.gov/ 
2. Click on “Access Viewer” from the menu bar and use user name: FireXdata and password:  FireXdata to launch the viewer.
3. Zoom to your fire using the “Zoom In” icon on the top toolbar or select it from the list available in the “Quick Zoom” tool window.  Before focusing in too closely on the fire itself, write down the names of the quadrangles for further reference or print the view. 
4. Click on the “Select Area” icon on the top toolbar.  A message appears that says, “Drag a box on the map image to define area of interest.” Click [OK].
5. Draw the box containing the area of the fire leaving enough space on the edges for growth and to show important features that you will see in the imagery as well as ones you want to show in your map.
6. The order form pops up with the bounding rectangle defined at the top.  Fill in all the required (*) fields.  Use phone numbers and an email address that you can easily get to from your assignment in the middle of the night.  If something goes wrong, the team will get hold of you to get your data to you.
7. Order the DRGs, topo/shaded relief blends, shaded relief, and/or NAIP quads.  Remember to fill in the appropriate zone for the UTM and Datum (WGS84 or NAD83 recommended).  If the product you need is “grayed out” in the list, this means that your area of interest is too large, OR, that product may not be available for the area.  You will need to close the order form and redraw a smaller box.  You may have to order several overlapping boxes to cover the entire fire.  Since this is seamless data, this is not a big deal.
8. Submit the order.  Do NOT close the window until the message that the order has been received is displayed.  You are given a URL which tracks your order.
9. A message that the data is ready to be picked up will be e-mailed to the email address you submitted.  The message will have a link to the website where the data is located.  Go to the website and save the zipped up files to your “incident background” data folder.
For Forest Service employees the Image Server is an excellent alternative for topos and NAIP imagery.
   http://fsweb.rsac.fs.fed.us/imageserver/imageserver.html
You must be at a Forest Service or BLM facility, or have a VPN account to use Image Server.

2-C) Pre-work – Setting Up the Digital Work Area

1. Begin the process by establishing the recommended file structure and create the working shape files needed for the analysis:
2. fire name folder (yyyy_Firename)
3. IR flight data folder with subfolders by date (yyyymmdd)
4. incident data folder for vector and raster background data
5. products or working data folder with subfolders by delivery due date (yyyymmdd)
6.  (
Year_Incident
 
Name_IR
 (Example: 2006_pigeon_ir)
base_data
products
ir_data
 
projects
 
(.mxd)
raster
temp
 
Delivery Due Date (Example: 20060926)
vector
Delivery Due Date (Example: 20060926)
from_fire
 (IR Order Form)
)Recommended directory structure and file names:
7. Delivery date refers to date of morning briefing – used for naming folders
8. Collection date refers to date of collection – used for naming files (along with collection time)
9. Can have same collection date but different times for different deliver dates, for example:
Imagery collected at 0120hrs on 9/25 used for 9/25 morning briefing: 
20060925_0120_Pigeon_IR_heatperim.shp in folder 20060925
Imagery collected at 2025hrs on 9/25 used for 9/26 morning briefing: 
20060925_2025_Pigeon_IR_heatperim.shp in folder 20060926

10. Recommended file name structure is name of fire, data of collection, time of collection, IR, type of shape file, projection (optional)  
Example: 20060925_2025_Pigeon_IR_heatperim_UTMZone12NAD83.shp
11. To be able to manipulate the data and create the map, ArcMap needs to be set up with the appropriate tools.  To ensure it is set with all the needed tools,
Click on Tools on the Main Menu, select “Extensions…” and check the following extensions: 3D Analyst, Spatial Analyst, and XTools Pro*.
Click on Tools on the Main Menu, select “Customize…” and check the following toolbars: Main Menu, Data Frame Tools, Draw, Editor, Effects, Layout, Spatial Analyst, Standard, Tools, and XTools Pro*.  (* not needed in version 9.2 or higher)




2-C) Pre-work – Downloading Phoenix data

Since 2009, most Phoenix data has been downloaded directly from the planes to the ftp.nifc.gov site through the AirCell system.  The data folder in which this data is kept requires a username/password to access it.
1. If you are using Internet Explorer 8, you must make sure the settings allow you to view FTP folders.  This setting also allows you to login with the username/password for the folder.  At any time before going to retrieve Phoenix data, in IE8, go to ToolsInternet Options.  Click on the “Advanced” tab and make sure there is a check mark in the box next to “Enable FTP folder view (outside of Internet Explorer).”
2. Go to ftp://ftp.nifc.gov and following the instructions there, click on Page, and then click “Open FTP Site in Windows Explorer.”
3. In the new window (or if you got here through My Network Places), go to FileLogin As…  Type in the NIROPS username/password and click on the Log On button.
4. Logging in drops you into the NIROPS folder.  The Phoenix data is delivered to a subfolder named for the current calendar year such as 2011_Fires.  Go to this directory, use the detailed display and sort the list by the Modified column so the most recent uploads are first on the list.  Your data will either be in a self-exploding exe file or a zip file.  Be sure the file has completely uploaded before downloading it.
5. Download the file by selecting it, copying it, and pasting it into your work area; or selecting it and going to EditCopy To Folder.  Once it is on your computer, the file can be uncompressed either by “running” the exe or unzipping the zip.


3) Viewing Phoenix Data in ArcMap
Now it is time to start creating the fire perimeter map.  
NOTE:  Because of the way ArcMap re-projects on-the-fly, the data frame properties need to be set to the same projection as the background data which is usually the projection in which the products are needed.  This can be done by adding one of them first or by defining the properties of the frame to match.  This will resample the ortho.tiff which causes an apparent loss of single pixels of heat.  This affect can be minimized by keeping the un-orthorectified imagery handy and using the RawHeatData shapefile.
1. In your new project file (.mxd) set the map document to “Store relative path name to data sources.  Select File, Document Properties, and then select “Data Source Options.”  This will allow you and other IRIN to exchange projects with the data sets without need to locate or reset the paths to the data sets, after projects are exchanged.
2. Add the base layers you are going to use for the analysis.
3. Add the local layer data from the “incident data” folder such as roads, streams, lakes, etc to ease location of the perimeter and heat locations.
4. Download and uncompress the Phoenix data if you haven’t done so already.
5. Add the ortho.tifs, color ortho.tifs and other IR flight data from the “ir flight data” folder.  In order to see the base layer through the ortho.tif you have to use the effects toolbar to adjust the transparency and brightness of the ortho.tif layer.  To add the effects tool bar, go to View -> Toolbars -> Effects.  On the effects toolbar click on the down arrow for the layer and choose the layer you want to edit.  Click on the transparency or brightness button and adjust each image.  Start at 20% and play around with them until you can see through the IR strip to the layers underneath.  Or the transparency can be changed by right clicking on the name of the file in the table of contents, Properties…Display Tab, 20% Transparency, OK.
6. The first thing to do is to see how the imagery lines up with the base data.  Look for drainages, roads, meadows, rock outcrops, harvest units, ridges, lakes, ponds, etc; anything that you can compare.  Zoom in to at least 1:20,000-scale to see detail and minor shifts.  If the imagery lines up you are ready to start interpreting.  If the imagery does not line up, find out why.  There are many reasons why the imagery and base map will not match up exactly.  These include, but are not limited to:
a. The accuracy and resolution of the DEM used in the orthorectification process,
b. The accuracy and scale of the base map,
c. Age of the base map, 
d. Projection issues (all the imagery is projected using NAD 83 Transverse Mercator except for the RawHeatData.shp file which has no projection information).  NOTE: If you are using ArcGIS 9.2, you need to define the projection using ArcTools (Data Management Tools/Projections and Transformations/Define Projection) to Geographic Coordinate System, North American Datum 1983,
e. Excessive pitch and yaw during the flight, 
f. And/or errors with the Phoenix system’s IMU.
7. There are 2 ways of handling this:
a. Interpret the imagery as you used to but make the map digitally in ArcMap.  If you need to print a hardcopy, use the tiff and a program that will treat it like a photograph and print in true color.  You can use a second ArcMap session or a second data frame for this, or to display the un-corrected tiff.  
b. Correct the image digitally by assigning a coordinate system to the image and then geo-referencing or rubber sheeting it so it matches your base data.  (This will only be approximate.  See “geo-referencing raster datasets” or “rubber sheeting” topics in the ArcGIS Desktop Help.
8. Also, compare the edge marks of the ortho.tif to the un-orthorectified strip image (or the RawHeatData point file).  In places with very few and isolated heat sources, the reproject-on-the-fly display process can resample out the pixels and corresponding edge marks.  These are important to map so make sure you know they exist.
9. Save the map document (.mxd) from the Main Menu, File ->Save.  (In the recommended directory structure, example: /2006_Pigeon/projects/2006_Pigeon_IRwork.mxd)  Some IRINs like to have a copy of the mxd for each night and others like adding on to the same one.  This is personal choice.

4-A) Creating Shape Files: Using ArcCatalog to Create a New Shapefile
1. Open ArcCatalog.
2. Go to the working data directory you created above, right click on the folder and select “NEW” Shapefile.
3. Create a shapefile, designating it either a polygon or point file, and defining the projection.
4. Repeat until you have created the 3 or 4 files to be used in the analysis.
5. Or, create a shapefile from an existing fire perimeter.  If this is a new fire for you, you can use the GIS-ed or GPS-ed perimeter from the SITL.  Or make a copy from your last interpretation.  In ArcCatalog, highlight the desired shapefile and either right click and choose copy or use the copy icon on the Main Menu.  Navigate to the new day’s directory and paste it in.  Rename the shapefile for the new analysis.  In ArcMap, right click on the previous night’s shapefile name…choose Data -> Export, to make a copy of the file and add it to your table of contents.  When copying previous data, be sure to empty the intense heat polygons and the points (select all, then delete) since these will be different in the new imagery.  The heat perimeter will be added to and/or modified by the new interpretation.

4-B) Start Editing
1. Add the blank perimeter shapefile to your project.
2. Go to the Editor toolbar, click on down arrow and select Start Editing.
3. The Task: and Target: areas will activate.  For a new polygon, choose “Create New Feature” as the task and choose the perimeter file as the target.

4. Pick up the Sketch Tool (pencil). [image: ] Single click around the heat to create the polygon (zoomed in to 1:10,000) and double click to finish.
5. Or, to stream when creating a polygon, set the stream mode by hitting the Editor down arrow and click options, then choose the General tab.  At the bottom of the box is the stream mode.  Start out with the stream mode at 20 map units (=meters) and the group of 30 or 50 map units together.  You may want to increase the mode if the perimeter is large so you don’t have to store as much data and thereby using less memory.
6. Click on the Sketch Tool (pencil) and then, on the map, click the spot at which you want to start.  Move the cursor a little then hit F8 to start streaming.  Move your cursor around the fire area to establish an initial perimeter.  To finish the polygon, stream until you are almost at the beginning point.  Right click and choose “finish sketch” or hit F2.  The program automatically closes the polygon.  Go to the Editor down arrow and click “Save Edits”.  If you are done, go to the Editor down arrow and click “Stop Editing”.
7. Remember to save the edits FREQUENTLY!
8. Save the map document (.mxd) from the Main Menu, File ->Save.
9. Continue to create/edit the intense heat and the isolated heat files with the appropriate blank shape files you previously created and develop the map layout.  When creating the polygons and points there are a few things to remember:
a. Use the least distorted imagery strip to map the heat.  The least distorted imagery is in the center of the strip.  The edges where the scanner is looking sideways and areas of high relief will have the most distorted information so where necessary, switch to the strip where the portion of the imagery is most centered.
b. If you have to use imagery on the side of the strip, use your interpretation skills to locate the actual heat onto the maps.  Steep terrain stretches the data giving it a lacey appearance.
c. While using the b&w imagery it often appears that a clear line where the actual fire was is not always obvious.  The color imagery can clear up any questions as to where to draw perimeter lines.  Heat above the threshold is denoted by the red color.  Yellow indicates areas that have already burned and gone out but where there is a lot of heat.  Use the 2 types of orthos to decide where you draw the line.
d. Be sure to use all the strips and map all the heat.  An active fire will grow between strips in the time it takes the plane to turn and come back over.
e. Be sure ALL the edge marks and small heat sources are accounted for in the orthos.  They can be re-sampled in the display and hiding.
10.  Remember to save the edits FREQUENTLY!


4-C) Tips and Tricks
1. Add to an existing perimeter by using the Modify Feature task.  Pick up the Sketch tool (pencil), click inside the existing polygon, single click around the fire you want to add, then double click back inside.  The polygon will pop out to the new perimeter.  (To subtract from an existing polygon, start and stop outside it.)  Another way to add to an existing polygon is to create a new polygon that overlaps the old one.  Then select both and in the Editor pull down menu, select Merge.
2. Some shortcut keys that are handy to use while editing:  [c] lets you pan, [z] zooms in, [x] zooms out, and [Esc] cancels the task.
3. [image: ]Use the Trace Tool to copy a piece of one polygon for a new one.  This is particularly handy when creating intense heat polygons so they match the perimeter.  Pick up the Trace Tool, click on the edge of the selected polygon where you want to start the trace, drag the tool along (red line follows) as far as you want to go, click once and pick up the Sketch Tool, continue creating your new polygon and double click when finished.
4. Define the projection of the RawHeatData.shp file before adding it to the map document.  Use ArcToolbox-Data Management Tools-Projections and Transformation-Define Projection.  In the Define Projection window, select or browse to the shapefile in the “Input Dataset” field.  To populate the “Coordinate System” field, click on the icon to the right of the field (a hand holding a sheet of paper).  In the Spatial Reference Properties window, click the [Select…] button, then browse to Geographic Coordinate Systems/ North America/ and add North American Datum 1983.prj.  Click [OK] twice to run the command.  If you had the shapefile in the document, the points will now display in the correct place.
5. If you are using ArcMap 9.0 or 9.1, calculate acreage by either using XTools or the vb script available from the ftp://ftp.nifc.gov/NIROPS site.  To use the script, first define a field in the attribute table named acres as a type double with both the precision and scale set to 16.  Then right click on the field name and chose Field Calculator…  In the Field Calculator window, check Advanced, the click [Load…].  Browse to the acres.cal script and click [Open].  Click [OK] to run the script.
6. ArcMap 9.2 has a utility built into the attribute table to calculate acres.  First, define a field in the table named acres as type double and precision and scale set to 16.  Then right click on the field name and chose Calculate Geometry…  Select Area for Property: and Acres US for Units: and click [OK].
7. Use the same .mxd.  Keep the Table of Contents uncluttered by grouping each night’s imagery and shapefiles and naming the group by the delivery due date.  The whole list can then be reduced to one item in the TOC and turned on or off with one click.
8. Create KML files.  Use the Google Earth tool (Export_to_KML Ver. 2.4.5) to export the data into a .kml file.  If you do not have this tool, it can be downloaded from http://arcscripts.esri.com/.  After installing the tool, launch it from the Google Earth icon now on the ArcMap tool bar.  Select the layer to be exported and the attribute field that you wish to be labeled.   Save to the products directory.  Select OK.  Another box will appear inquiring if you would like to open Google Earth- click Yes.
9. Set the ‘Sticky Move’ high (100 pixels or more) in the Editing Options so you won’t move a polygon by mistake.  The GISSs hate when that happens.  Another option to set is to rearrange the tasks so the ones you use most often (such as Create Feature and Reshape Feature) are at the top of the list.

4-D) Making Maps
1. Display your heat perimeter with a solid red 2-pt line, intense heat with red cross-hatching, and isolated heat sources with solid red 8 or 10-pt circles.  The previous day’s perimeter can be shown with a solid black line under the current line.  Scattered heat can be displayed with a red dotted pattern.  Be sure to clear all feature selections so they won’t plot in cyan.
2. Include these items in your layout:
a. Title box which includes the fire name, “Infrared Map”, your name, date and time of imagery acquisition, and calculated acreage.
b. Legend.  Include all the shapefiles you created.  These may include other polygons or lines you used to show where the imagery was obscured by clouds, areas of super-heated gas, or where there was not coverage.  A handy trick is to rename these items in the table of contents so the legend does not have the long file names listed.
c. North arrow.
d. Scale, both absolute (1:24,000) and a scale bar.
e. The NIROPS logo.  You can use the one at the beginning of this document or pull it off either the ftp.nifc.gov/NIROPS site or the nirops.fs.fed.us site.
3. The size and scale of your map depends on the requirements of the SITL and the size of the fire.  A common standard is 11” x17”.  Most ICPs have a printer that can print to this size paper.  Play with the scale until your fire fits in this layout plus room for the other items and identifiable features on the background DRG.  Export to a pdf at 300 dpi and imbed the fonts (options) so it will print out the same no matter what printer is used.  Name the pdf with the fire name, IRmap, and delivery due date.  Image backdrops are nice but can loose detail at small scales or print out really dark.  Print one out for your records and one to take with you to camp in case they haven’t seen it yet.

[image: Hidden_CA_IRwork]
5) Delivering the products
The ideal scenario is that you are working near ICP and can deliver your products and give a briefing to the SITL in person before the incident morning briefing.  The instructions below are for loading your data onto an ftp site.  Remember that you work for the SITL so do not distribute or release your data without his/her permission.

1. Zip up all the shapefiles into one file for delivery.  This way nothing important will be left behind.  
2. Send the log and pdf separately.  The log will tell whoever is retrieving the data what they need to know.  The pdf can be quite large so send it by itself after the other data is posted.
3. Call your contact person if they have asked to be called.  Many GISS and SITLs start looking for the data at 0400 or so.  Post a readme file or something similar if you cannot get hold of them by phone so they have something to find and know to get hold of you.
4. Upload your interpreted data to the incident ftp site!  The username/password combinations that give you access to these directories are listed in the IRIN_one_page_tips.pdf found on the nirops.fs.fed.us website.  If an IR directory does not exist, create it at the same directory level as the GIS directory, shown in the example below in the Red/Black box.



5. Keep raw data and imagery in the NIROPS site if that is where it was delivered to you.  This minimizes the chance that the raw data will be misused.
6. Be sure to give and receive feedback so you can place the next scanner order and meet the needs of the incident.  Remember to communicate with the regional or national coordinators as well as the IR technicians.













6) Other information


Instructions for installing a hardware key (USFS):

Instructions for using single-use license (USFS):

Instructions for adding kml button.
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